
 <<YourApp>> Help Index

How To ...
<<add your application-specific "how to" topics here>>

Commands
File menu
Edit menu
Record menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Exit Exits <<YourApp>>.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another application.
Insert New 
Object

Inserts and embeds an object, such as a chart or an equation in a document.

Links List and edit links to embedded documents.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in <<YourApp>>.    Select the type of new file 
you want to create in the File New dialog box.    << Remove previous sentence if your 
application supports only one document type. >>

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

<< Delete this help topic if your application supports only one document type. >>

Specify the type of document you wish to create:
<< List your application's document types here >>



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which <<YourApp>> stores the file that you want to open. 

Directories
Select the directory in which <<YourApp>> stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    <<YourApp>> 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, <<YourApp>> displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, <<YourApp>> displays the Save As dialog box so 
you can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    <<YourApp>> displays the 
Save As dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    <<YourApp>> adds 
the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your <<YourApp>> session.    You can also use the Close 
command on the application Control menu.    <<YourApp>> prompts you to save documents
with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    
Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in <<YourApp>>, such as File Open.    A check mark appears next 
to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in <<YourApp>>,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your 
application offers. >>

Click To

Open a new document.

Open an existing document.    <<YourApp>> displays the Open dialog box, in which 
you can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, <<YourApp>> displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.

Go to the first record in the current selection.

Go to the previous record in the current selection.

Go to the next record in the current selection.

Go to the last record in the current selection.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the <<YourApp>> window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

<<YourApp>> displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.  
Choose a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using <<YourApp>> and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
<<YourApp>>.



Context Help command 

Use the Context Help command to obtain help on some portion of <<YourApp>>.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the <<YourApp>> window, such as another 
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the <<YourApp>> window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    <<YourApp>> 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    <<YourApp>> 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>

                  





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>

    



Swix and the X.500 directory.

The purpose of the X.500 directory is to facilitate communication. It is a global database of 
information about objects such as persons and organisations. You can compare the directory to a 
world wide telephone directory. Typical information you can expect to find is telephone numbers
and electronic mail addresses.

Swix is a program which allows you to find information in the directory and keep it in your own 
address book. You can also use Swix to update the X.500 directory.

Swix overview.
Installation.
The X.500 directory, some technical issues.
How the information is structured.

Find examples.
Browse examples.

The UFN text box.
The List View.
The Entry View.
The Edit View.
The Message View.

Menus:

File.
Edit.
Directory.
Layout.
Configure.
Help.



Swix overview.

In Swix you can retrieve information from the X.500 directory in two ways. You can Find an 
entry by giving a User Friendly Name (UFN) in the UFN text box at the top of the main 
window. An example of a UFN is "lindahl, umdac, umu, sweden". The other way is to enter a 
name in the text box and then use the Browse function to list all entries below the one that you 
specify.

In the text box you will see a name like "Umea Universitet, SE" or the name of your organisation
if someone else has installed Swix for you. You can change this initial name to suite your needs 
by using the configure/search menu. To find a person within the organisation "Umea Universitet"
you just enter a name in front like "Goran Lindahl, Umea Universitet, SE". To browse within the 
organisation click on the Browse button.

Now, if you don't know how the directory is structured or the naming of the objects there is a 
short chapter which you can study. This and a few search examples should be enough to get you 
going. By the way, you can clear the text box to browse from the top level of the hierarchical 
catalog.

If the name you enter is not enough to find the entry in one go, Swix will try to find it by 
searching at the different levels of the directory. Swix will show you what is going on in the 
Message View at the bottom of the screen. In this window you can follow the progress of the 
search if you are interested.

If the search is successful you will see the result in two other windows, the List View and the 
Entry View. In the list view you will have a list of all the entries retrieved and you can scroll the 
list and select an entry by clicking on it. The selected entry is displayed in the Entry View. You 
can even specify the order in which the entries will appear. For example you might want to have 
the entries sorted on surname (last name). In the List View each entry is one row of information, 
by default the Distinguished Name of the entry is displayed. In the Entry View the attribute 
values of one entry are displayed on separate lines.

Save the document and you have your own private address book. The next time you need the 
information you don't have to search in the global directory. Well, if the information is getting 
old you may want to retrieve it again, of course.

You can also write a tab separated textfile with, for example, telephone numbers and E-mail 
addresses. Import the    textfile to your word processor and print an address list.

You can update the x.500 directory assuming, of course, you have permission to do that. The 
Entry View will
then be replaced by the Edit View.



Installation.

You have to have:

- At least a 386 machine running Windows 3.1
- TCP/IP communication with a winsock.dll

The most recent copy of Swix can be found by FTP from ftp.umu.se in the directory 
pub/pc/swix. It is a self extracting file which will give you the necessary files to run Swix and 
this documentation in Write format.

Installation.

Create a directory, for example c:\swix.
Copy the installation file, for example swix21.exe, to this directory,    
and then run swix21.exe in this directory.

You will now have the program swix.exe. Open the program group where you want to create the 
new icon and create a new program object with information resembling this: 
Description:            Swix
Command Line: c:\swix\swix.exe
Working directory: c:\swix

You may want to change the default server and default initial UFN. Use the configure menu in 
Swix or, if you are installing for other users, you may want to edit the file default.cfg.

Files in the installation directory:

swix.exe X.500 directory user agent.
libldap.dll ldap library (c) Regents of the University of Michigan.
swix.hlp Swix help file.
attrib.cfg Attribute table.
layout.cfg Default attributes in the Entry View.
defaul.cfg Default startup values.
edattr.cfg Default attributes in the Edit View.
swixobj.cfg Definition of objects.
temp.cfg Templates defining the layout in the Edit View.
readme.txt File list and version news.
swix.wri This documentation in Write format.
seuppdat.wri Write document in Swedish: Uppdatering av X.500 katalogen från Swix.

ATTRIB.CFG

This file contains attribute names, attribute types and attribute labels. The labels will be used in 
the Entry View. You can edit this file, for example change the labels or add new attributes, but 
you should not attempt this unless you know what you are doing.



LAYOUT.CFG

This file contains the default Entry View attributes and will be used each time a new document is
created.

DEFAULT.CFG

Contains default values like the name of the server. A manger installing Swix can edit this file for
local needs.

Modifying the X.500 catalog.

The following configuration files holds information necessary for updating the X.500 catalog.
Usually a manager will edit these files to suit local needs.

EDATTR.CFG

If no template can be used (defined in templ.cfg) then this file will decide the attributes that will 
be editable in the Edit View. If this file is deleted or renamed then templates must be used to 
create an Edit View.

SWIXOBJ.CFG

This file will be used when modifying or creating a new entry. Specifically when creating a new 
entry the object that is to be created is defined here. These objects are also used when you create 
a template (in templ.cfg).

TEMPL.CFG

A template defines the Edit View layout used when modifying or creating a new entry. The name 
of the template should be the same as an object defined in swixobj.cfg. In the template you can 
specify if an attribute value must be filled in and also a default value.



The X.500 directory, some technical issues.

This information is not really necessary to run Swix. However you will see some technical terms 
in error messages and if you do not allude know their meanings this chapter tries to supply you 
with that knowledge.

The program that retrieves information from the directory is called a directory user agent (DUA).
Swix is a DUA for Windows. The communication can be described as follows where    "A --> B" 
means that A is requesting information from B.

user    <-->    DUA (directory user agent)    -->    the directory

Because of its size the directory is distributed over a large collection of computer systems. This 
mans that the directory is a collection of directory system agents (DSAs) which cooperate to 
provide the information:

user    <-->    DUA    -->    DSA    -->    other DSAs (if necessary)

Some other terms which are used to describe this communication is client and server. The DUA 
is a client which requests information from the server (DSA).
When you request information from the directory you thus have to be connected to a server. 

However, there is something more involved called a LDAP server. This server is there to 
facilitate the development of client programs. The server you will contact when you run Swix is 
therefore a LDAP server, you enter the name of this server    under the "Configure/Server" menu. 
If you are running Swix it will look like this:

You    <-->    Swix    -->    LDAP server    -->    DSA --> other DSAs

You can see the names LDAP server and DSA in error messages:

The error message "Can't contact LDAP server" means that the first communication step from 
Swix failed and you can't access the X.500 directory (unless you can find another available 
LDAP server).

When you get "DSA is unavailable" the error is in either of the last two steps. If the LDAP server
can't contact the DSA you will get the error at once when you try to search. In that case you can't 
reach the X.500 directory.

If you get "DSA unavailable" when a search has started it means that the server or DSA that you 
are connected to tried to contact another DSA but that server did not respond. In that case you 
can't reach that part of the directory which is hold by the DSA that is unavailable.



How the information is structured.

The directory is made up of entries, each of which is composed of information about one object. 
An entry is made up of attributes, each concerned with some aspect of the object.

Example: An entry describing a person may contain these following attributes:

commonName Goran Lindahl
telephoneNumber +46 90-166070
mail Goran.Lindahl@umdac.umu.se
postalAddress UMDAC

901 81 Umea

The name of the entry is made up of one or more attributes. In the case of the entry being a 
person this is typically the attribute commonName. But that's not enough ...

In a world wide distributed system such as this the naming of entries is not so simple. The name 
has to be unique and also the DSAs have to know where to search. The directory is therefore 
structured as a tree. The complete name of the object is made up of the names of the entries 
above it in the tree. This unique name is called the Distinguished Name.

The hierarchy is most often set up in the following way. On the top level we have a country, 
below that an organisation and under that possibly one or more organisational units. These are 
also entries in the directory. The attribute names used to name them, with their abbreviations in 
brackets, are country (c),    organization (o) and organizationalUnit (ou) respectively. 
CommonName is abbreviated to cn.

At the bottom of the tree we have entries which are called leaves. One example is the person 
above. He is working at the Computer Centre called umdac at Umea University in Sweden.    The
distinguished name is:

cn=Goran Lindahl, ou= umdac, o= Umea Universitet, c=SE

Note that the names are written in the form attributeName= value and that the order is bottom 
up.When searching for a specific entry Swix uses the above notation. However you don't have to 
be that specific. There is something called User Friendly Name (UFN) that allows you to omit 
the attribute names. To search for the distinguished name above you could use:

Goran Lindahl, umdac, Umea Universitet, SE.

The uniqueness requirements leads to long names but there are often shorter forms or alternative 
names in the entry which you can use. Swix will use these when searching for the entry. For 
example the organisation entry "Umea Universitet" also has the following organisation attributes:
"Umea University" and "umu". Because entries that are persons have the attribute surname you 
can even omit the first name:



Lindahl, umdac, umu, se



Find Examples.

If you want to retrieve a specific entry you enter the name in the text box immediately above the 
List View, and then press the Find button or the Enter key. The search is not case sensitive. By 
convention only ascii characters are used in a distinguished name. However national characters 
may be used in alternative values. Suppose you enter the name:

Goran Lindahl, umdac, Umea Universitet, SE

This should give you one entry in the List View and that entry is also displayed in the Entry 
View. The last message in the Message View which should "Added" meaning the search was a 
success and the entry was added to the document.

An alternative way of writing the above entry is to use the distinguished name with the attribute 
names. Normally you don't use that form but for completeness we show it here:

cn=Goran Lindahl, ou=umdac, o=Umea Universitet, c=SE

It is also possible to use shorter forms of names where these exist:

Hedberg, umdac, umu, se

For example "umu" is a shorter name for Umea Universitet and we can also use the fact that 
entries have a surname (last name) attribute. In the Message View you should find that Swix 
found the component "se" but had to search for umu, and then again for Hedberg.

The top level is most often a country but there are some international organisations. The name of 
the country is, as you have seen, a two letter country code. There are alternate names if you don't 
know the code:

lindahl, umdac, umea university, sweden

For the last two components in the name, which are at the top of the directory tree, we use the 
existing English names.

You can omit components in the name:

lindahl, umu, se

Component omission is sometimes quite all right but there may be many more entries for Swix to
search through. There are in fact two people with the name Lindahl working at "umu". Swix will 
then display a list box with two entries and you can select one or cancel the search.

If there is no match Swix will try an approximate match. This way you may succeed in finding 
an entry although you have misspelled it:



Ulin, umdac, umu, se

Will find the entry Stig Uhlin, umdac, Umea Universitet, SE, although "Uhlin" is misspelled.

You can also use wild cards in the search:

lind*, umdac, umu, se

Since there are several people working at Umdac whose name begins with "lind" Swix will 
display a list box with the entries.

You can in fact replace whole values with wildcards:

*, *, norway

After finding the country all entries will match and Swix will display    the list box. You choose 
one entry and then the same thing will happen again at the next level.



Browse Examples.

Consider the entries:

se
umu, se
umdac, umu, se

Neither of the above three entries are leaves. The first is a country, the second is an organisation 
and the third an organisation unit. All of them have entries below them in the directory tree 
which you can list. If you want to browse through all departments in Umea university you type 
the following and click the browse button:

umu,se

Another example of browsing:

matematik,umu,se

If you click the browse button you should see all entries in the department of mathematics.

As a last example of Browse, but the easiest to use, enter no name at all. If the text box is blank 
you will get the top level of the directory. You will then see a lot of country codes, DSAs (usually
animal names) and some international organisations. If you click on one of the entries the name 
will be copied to the text box and you can continue to browse.



The UFN Text Box.

In the text box you enter the name which you want to search for.

After a successful search or when you click on an entry in the List View the name of that entry 
will be moved to the text box.

If you want to clear the text box you can press Ctrl+D.



The List View.

In the List View all entries in the document are displayed, one entry on each row. By default the 
Distinguished Name of the entry is displayed but you can display any attribute, by using the 
"Layout/List View Layout" menu.

If you want to change the number of rows that are visible you can drag the bar that separates the 
List and Entry Views.

The current entry is highlighted. To change the current entry click on another row in the List 
View. After the click you can also use the direction keys to select a new entry. You can also move
by typing a letter, which will move to the next entry starting with that letter. The Home and End 
keys will move to the first and last entry.

By default the Distinguished Name of the entry is displayed but you can specify the layout by 
using the "Layout/List View Layout" menu.



The Entry View.

In the Entry View one entry is displayed. To display another entry in the document click on a row
in the List View.

If you want to change the size of the Entry View window you can drag either the bar that 
separates it from the List View or the bar that separates it from the Message View.

If you want to change the default attributes which are displayed use the "Layout / Entry View 
Layout" menu. 

You can select values in the Entry View by clicking on them. Use Shift+Click to select more than
one value. The selected text can be copied to the clipboard by the normal Ctrl+C key 
combination.



The Edit View.

When you are modifying or creating a new entry the Entry View will be replaced with the Edit 
View. To be able to do this you have to select the user entry that corresponds to the user and use 
"Directory/Bind As" to authenticate yourself by entering a password.

You can move between the fields with the Tab and Shift+Tab keys or by clicking on the field. 
Each edit box contains as many rows as there are values for that entry. To enter new values use 
the Enter key to open up a new line. If you enter values longer than the edit box the text will 
scroll in the box. Please note that two rows of information are two different values for that 
attribute, except for postal addresses, and that the ordering of the values can not be guaranteed.

Attributes of type PostalAddress have values which contain lines. You enter each line of data on 
a new line in the edit box. If you have to enter more than one    postal address, separate them with
an empty line.

Attributes of type Password are shown as usual, with the characters replaced by '*'.

To make the changes in the X.500 directory (and in the document) click on the Update button. To
cancel the update use the Cancel button.



The Message View.

In the Message View you will see messages from Swix as a result from operations against the 
server. All items in the directory menu will cause actions against the server. Only messages from 
the last operation are kept. If you want to display more rows in the Message View you can drag 
the bar that separates it from the Entry View.

The last message in the Message View after a successful "find" is one of:

Added: The entry was found and is added to the document.
Replaced: The entry was found. It was already in the document and has now been

updated.

After a successful browse you will see the number of added and replaced entries.

If you are modifying the X.500 directory you will see an error message if the update request
was not successful.

If you see the message "Waiting for results" Swix is waiting for the server to return the results.



The File Menu.

File / New / Open / Save / Save As.

You can create a new document, open an existing document and save the document in the 
standard Windows fashion. The default extension for Swix documents is ".swx".

File    / Most Recently Used file list.

This is a handy alternative to the File/Open menu. In the File menu the four most recently used 
documents are displayed.

File / Print / Print Preview.

Swix offers at present some limited printing capabilities. If    you print the List View all entries 
will be printed. You can also print the Entry View but then only that single entry will be printed. 
The Message View is also printable. Please click with the mouse in the appropriate View before 
you select "Print" or "Print preview" from The "File" menu.

File / Write Textfile.

You can write a tab separated textfile. The file is based on the List View and the attribute values 
are separated by a tab character. This makes the file suitable for a word processor.

You may first want to change the List View layout, for example add telephoneNumber and E-
mail address (mail). If all entries are in the same organisation you may want to remove the 
Distinguished name and instead add the commonName.

File / Exit.

You can exit Swix with this menu alternative or use the Exit button. If you have not saved the 
document    Swix will prompt you.



The Edit menu.

Edit / Undo Ctrl+Z.

Undoes changes in the UFN edit box or changes made to an attribute value while updating an 
entry.

Edit / Cut Ctrl+K.

Deletes the selected text and copies it to the clipboard. You can cut from the UFN edit box or the 
attribute field in the Update View.

Edit / Copy Ctrl+C.

Copies selected text to the clipboard from the UFN edit box, from attribute edit boxes while 
updating an entry and from attribute values in the Entry View. To select values in the Entry View 
you click on it. To select more than one value hold down the shift key and click.

Edit / Paste Ctrl+V.

Paste inserts text from the clipboard. You can paste into the UFN edit box and into attribute 
fields while updating an entry.

As an example you can move text between an attribute which contains a distinguished name and 
the UFN edit box to look it up. Click on the attribute value in the Entry View, press Ctrl+C, and 
then click in the UFN edit box. Clear the edit box (Ctrl+D) and then paste with Ctrl+V.

Edit / Clear UFN Text Box Ctrl+D.

Use this menu item or press Ctrl+D to empty the text box.

Edit / Delete entry.

This will delete the current entry from the document. You will get a message box to confirm the 
deletion.

Edit / Clear document.

You can delete all entries from the document. A message box will ask you to confirm the 
deletion.



The Directory Menu.

Directory / Find Ctrl+F.

The menu item "Find entry" and the Find button accomplishes the same thing. Swix will try to 
find the entry matching the name you have entered in the text box.

You can click on an entry in the List View to move the name to the text box.

Directory / Browse Ctrl+B.

The menu item Browse and the Browse button will both try to retrieve all entries below the entry
you specify in the text box. The first step is actually the same as find, that is to see if the entry 
exists. However, in Browse you can have an empty text box. In that case the Browse will be 
performed on the root of the directory tree.

If the results from a browse are organisation entries you might want to continue browsing. To do 
that click on an entry in the List View to bring the name to the search text box and click on the 
browse button again.

Directory / Bind As.

You can authenticate yourself by giving a user name and a password. In the user field you can 
either type the user or select a name from the list box. In the list box you will see all the entries 
in the document.

You can save the user name by checking the "Save as default" check box.

If you want to bind unonymous, which is the default, click the Anonymous button.

If the authentication is successful you will see the message "Bind OK" in the Message View.

Directory / Modify. Ctrl+M

Modifies the entry in the X.500 catalog. Before you can modify the current entry you must use 
the directory/bind menu to enter user and password information. The Entry View will be replaced
by the Edit View where you can modify the attribute values. Click on the update button to make 
the changes in the X.500 catalog. Use the cancel button to cancel the operation.

Directory / Modify RDN.

Modifies the relative distinguished name of the entry. Before you use it you must use the 
directory/bind menu to enter user and password information.

Click on the update button to make the changes in the X.500 catalog. Use the cancel button to 
cancel the operation.



Directory / New.

Creates a new entry in the X.500 catalog. Before you can modify the current entry you must uuse
the directory/bind menu to enter user and password information.

The first step is to select the entry under which the new entry is to be created, assuming that it is 
already in the document. When you create a new entry you will get a dialog where you can 
choose what kind of entry to create, for example a new person or organisational unit. The next 
dialog will prompt for the relative distinguished name of the new entry and after that the Entry 
View will be replaced with an Edit View where you can enter the new attribute values.

Click on the update button to add the entry to the X.500 catalog. Use the cancel button to cancel 
the operation.

Directory / Repeat New Ctrl+R.

When you have added a new entry with Directory/New you can use this function to create more 
entries of the same type in the same directory. You will save time as you don't have to select the 
directory entry and select an object type again. Otherwise it is the same as Directory/New.

Directory / Update Ctrl+U.

When you are modifying an existing or a new entry this menu item will update the X.500 
catalog. The function is the same as clickin on the Update button.

If the update is successful the edit View will be replaced by the Entry View otherwise you will 
get an error message in the Message View. Either correct the error and try again or else click on 
the cancel button to end the editing.

Directory / Delete Ctrl+Del.

You can delete the current entry from the X.500 catalog. You must use the directory/bind menu 
to enter a password. The entry will also be deleted from the document. You will get a message 
box to confirm the deletion.

Directory / Cancel.

While any operation in the Directory menu is going on you can click the cancel button to abort 
the operation.



The Layout Menu.

Layout / Sort.

There are four different ways to order the entries:

1. By the distinguished name.
2. By organisations and attribute.

Example: Sort by surname (last name) within the organisations.
3. Sort all entries by attribute:

Example: Sort all entries by telephoneNumber.
4. Sort them in the order that they where retrieved.

In this order you will get the last retrieved entry also last in the List View.

Select the sort order by clicking on an appropriate radio button. Two of the types have an 
attribute associated which you can select from a combo box. Click on the down arrow button to 
open the attribute list.

Layout / List View layout.

In the dialog there are two list boxes. The first one displays all attributes. In the second one are 
the selected attributes or the Distinguished Name in the order in which they will be displayed.

By default the distinguished name is displayed in the List View. You can, however, display other 
attributes in the List View. Select the attribute from the left list box and click on the right arrow 
button to move it to the selected attributes list box. The attribute is inserted before the selected 
item in the right list box so you may want to select the position first by clicking in the right 
"selected attributes" list box.

If the distinguished name is not selected you can add it with the "Add DN" button.

If the check box labelled "Show attribute names" is checked attribute names will be displayed.
The format is attributeName= attributeValue.

Layout / Entry View Layout.

In the dialog there are two list boxes. The first one displays all attributes. In the second one are 
the selected attributes in the order in which they will be displayed.

To add an attribute, select it and click the right arrow button. As a shortcut you can double click 
on the attribute.

The attribute is inserted before the selected item in the right list box so you may want to select 
the position first by clicking in the right "selected attributes" list box.



To delete an attribute click on the item in the right list box and press the left arrow button or 
double click on the attribute.

You can insert blank rows by clicking the "Add blank" button. The line is inserted before the
selected item.

You can add all attributes to the display list with the "Add All" button and you can remove all 
attributes with the "Remove All" button.



The Configure Menu.

All changes under the configure menu are recorded in your swix.ini file in the windows 
directory.

Server Set up the server that swix connects to.
Search Set search parameters and initial UFN.
Launch application Associate an attribute with an application.



Configure / Server.

In the server field you type the Internet address of the server. In Umea enter: x500.sunet.se

Port is a field which you normally can set to zero, Swix will then use the default LDAP port.

If the keep connection check box is checked the connection to the server will be up from the first
operation until you end Swix ( or do a new "Bind as" or change of server). If unchecked Swix 
will disconnect after each operation.



Configure / Search.

The initial UFN list box.

You can change or remove the initial UFN . To remove it choose the NONE alternative in the list
box. You can set it to the name of any entry in the document all of which will be present in the 
list box.

Size and time limits.

Size limit sets a limit on how many entries are returned from the server.

Time limit sets a limit on how long the server should spend trying to answer your search request.

The approximate match check box.

Swix will try an approximate match if no exact match is found. The matching is done by the 
DSA and the result is sometimes strange. If there are too many matches it is not so harmful but 
sometimes a little spelling mistake may produce no match at all.

To disable approximate matching uncheck the check box.



Configure / Launch application.

You can associate an attribute with an external application so that when you double-click on the 
attribute value in the Entry View the applicaton will start. You can even specify parameters to the
application. This is useful when you wish to pass the attribute value.

To set up the connection between an attribute and an application you first display an entry that 
contains the attribute and then click on the value in the Entry View. 

In the dialog you will see the Label and the name of the attribute (in parentheses) on the first 
line.

In the Application edit box you fill in the path and name of the application. You can use the 
Browse button to get the path and name.

In the Parameter edit box you can enter parameters to the application. The percent character has
a special meaning: The entire value of the attribute will be inserted in the parameter string. 
Example:

Attribute: E-mail (mail)
Application: c:\xxx\yymail.exe
Parameter: %

A double-click on any mail attribute will start c:\xxx\yymail with the attribute value as a 
parameter.

Any other text in the parameters field will be passed unchanged, for example:

Parameter -r % -d john

will be passed as "-r " followed by the attribute value followed by " -d john.

You can also refer to different parts of the attribute value which are separated by blanks. To do 
this you specify a parameter number (1-9) directly after the "%". For the first part use "%1", for 
the second part use "%2", etc.

As an example the attribute labeledURL contains an url and a label which can look like:
http://macavity.umdc.umu.se/~roland/myself.html My homepage. (A space separates html from 
My)

Attribute: URL (labeledURL)
Application c:\netscape\netscape.exe
Parameter %1

The first part which contains the url is passed to netscape.



If no value from the attribute value is specified in the parameter field, that is it does not contains 
any %, the attribute value will be copied to the clip board. When the application has started you 
can easily paste the attribute value.



The Help Menu.

You can click on a help topic or search using keywords.




